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VECTORWORKS & FRILO
Workflow for structural analysis

This White Paper from Vectorworks and FRILO is a
guideline that offers you an integrated BIM workflow.
You will learn how to gradually move from the Archi-
tectural model in Vectorworks to the Analytical model
in FRILO.
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OPEN BIM is an advanced, future-proof approach
to AEC/O collaboration. It helps to connect stake-
holders such as software vendors, software users
(architects, engineers and building owners) and
builders to create great buildings.

Challenges for architects and civil engi-

neers

Architects and civil engineers depend on each other
in their day-to-day work. They are usually so busy with
their areas of responsibility that there is little time left
for the challenges of the other project participants.

That is why all actors in the construction industry
struggle with recurring difficulties. Long communi-
cation channels, constant planning changes and new
coordination are just a few of the points that rob you
of time in everyday life. Time that you normally don't
have. This creates more and more time pressure,
which at the end of the day gives you little freedom
for your actual work: the preparation of a high-quality
statics model and a thorough verification.

The OPEN BIM approach

The OPEN BIM approach should enable users to ex-
change data from building models regardless of the
software solution used. With continuous work pro-
cesses over the entire life cycle of a building, project
participants should work together in a goal-oriented
and efficient manner. One of the most important ex-
change formats here is the IFC file, which also plays
an elementary role in the subsequent workflow bet-
ween Vectorworks and FRILO.

One thing is very clear: not all users react to the OPEN
BIM approach with cheers. Many doubt the suitability
of this solution for everyday use and wonder whether
the workflows advertised actually work and help to
optimize data exchange and save time.

Recognize & understand working methods
An important prerequisite for the OPEN BIM approach
is that architects and structural engineers learn from
each other, tackle common challenges and recogni-
ze and understand new work processes. For this rea-
son, Vectorworks and FRILO have decided to provide
users with guidelines that will guide them step by step
through an OPEN BIM process. We will show you how
you can gradually move from the Architectural model
in Vectorworks to the Analytical model in FRILO.
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Our solution approach

Record the planning changes immediately

' You know this situation yourself. There are constant corrections and innovations in every planning process.
Wlth the OPEN BIM approach, however, these changes are recorded immediately and communicated to the
| various project participants.

' When transferring from the Architectural model to the Analytical model, you as a structural engineer can !
' make manual transfer errors. The workflow between Vectorworks and FRILO transfers relevant building data :
1 directly, which increasingly minimizes sources of error. I

1 Every communication costs time and energy. Thanks to a consistent workflow, you can shorten these com- :
, munication paths, leaving you more time for the actual work: structural planning. I

I'A good project location should actually make every architect and structural planner happy. However, this |
mood is often clouded by time pressure in complex construction projects. The OPEN BIM approach is inten- :
; ded to support you in making your project management more efficient and profitable again. I

: You chose your job because you enjoy developing the load-bearing structure of a building and understanding :
, Static problems. You actually like to dive into complex reinforcement problems and exciting static solutions. |
1 Unfortunately, manual processing processes, long communication channels and inefficient project proces-l
: ses rob you of the time for the essentials. With the approach between Vectorworks and FRILO, we would like ! .

1 to give you this freedom back.
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A guide for creating a well-structured architectural
model as a basis for transfer to the FRILO structu-
ral analysis software.

Structure the Building model

A basic requirement for the successful export of a
structural model from Vectorworks is a well-structu-
red architectural model. Make sure that the building
model is built up on a floor-by-floor basis. Make also
sure that all load-bearing components are stored in
classes in such a way that you can filter for the stati-
cally relevant elements before exporting. You can use
your own standard for this or structure it according to
an existing standard, such as according to the eBKP-
H standard (building cost plan building construction),
which has up to four standardized levels with cost
and reference value definitions.

kokliang1981 - stock.adobe.com

With the component properties "Load-bearing” or
"Outside” (e.g. for walls and slabs), you can provide
the structural engineer with additional information
that serves as a basis for his work (dialog window
"Wall Settings” or "Slab/Ceiling Settings”, "Data“ tab).

Prepare architectural model for export

With the help of the structural means in Vectorworks,
levels and classes, a shell model can now be crea-
ted with just a few clicks. The classes required for
the design layers can be filtered by simply hiding the
classes that are not required. The part of the model
that is now visible can then be exported as an IFC file
with the option Export Visible Objects Only.
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Custom IFC data mapping

Before the physical model is transferred to the FRI-
LO structural analysis software, user-defined as-
signments are assigned to the load-bearing com-
ponents in Vectorworks. In consultation with the
structural engineer, it was decided to enter the archi-
tect's material proposal in the “Component 1” field
of the IFC “Material” pset. This enables the building
materials of the building model to be filtered quickly
in the structural analysis software.

With the data manager you can assign the required
IFC information to the components. As an example,
we will show this in the following using the wall, slab,
column and structural member.

If you have already created individual assignments in
the data manager, save these under your own assi-
gnment scheme.

To do this, open the data manager dialog window
(Tools » Data Manager) and assign your own name.

Wall

The IFC property "Material” is assigned to the compo-
nent. If you are working with the IFC version 2x3, the
Pset “Material” must be added to both the “IfcWall-
StandardCase” and “IfcWall” entities (IfcWallStan-
dardCase is not applicable for IFC version 4).

The assignment takes place via the name of the core
shell of the created wall style.

See the images on the right.

Note: establish the designation with your structu-

ral engineer in advance.
See also page 12, Material assignment.

Data Manager

Settings: | <Document's Setti... E [ Open... J [ Save... J [

Manage... | IFC version: m IFC language: | Original < ‘

Objects: | |

Data Sets Attached by this Mapping: |

Data Sheets for this Mapping:

|Usa

|object Types/Object Names | | |attach |Data Sets/Fields

[Type

|Fie|d Mapping By Mapping ‘ |#

[sheet NamejField Source

JqV VvV

Class-based Objects
Symbol Definitions
Plug-in Objects (Third Party)

Plug-in Objects (Built-in)
(Legacy) Hoist

=
e e

Save Mapping Scheme

By,

Acorn Mut {inch)-3D
Angle - 3D

Save the current set of Data Mappings and Data Sheets as:

Base Cabinet IMy Settings

Bath-Shower
Blended Projector
Blended Screen

[ Save to User Folder

© Entire Mapping Scheme () Selected Object Only

Break Opening CW
Building CW
Bulb Flat - 3D

[Users/franksaenger/Library/Application Support/Vectorworks/2022/Settings

Carriage Bolt - 3D
Ceiling Grid
Channel - 3D

Save to Workgroup and Project Folders

Circular Stair

- # |Usc
Clevis Pin (DIN)-3D

|I'0 der Location

Clevis Pin (Inch)-3D
Clevis Pin (Metric)-3D
Clothes Rod

Column

Comm Device
Compartment Sink
Cotter Pin {Inch) - 30

R N N N

Conter oo

A

| Add Class-Based Object... | |

Edit... | [ Delete | [ Add{

| ‘Workgroup and Project Folders paths. |

Rename C

J

Fig.: Save your own mapping scheme
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[ NoN ] Data Manager
Settings: ] [ Open... ] [ Save... ] [ Manage... ] IFC version: | 2x3 & IFC language: | Original ¢ ‘
Objects: ‘ | Data Sets Attached by this Mapping: [ | Data Sheets for this Mapping:

Video Camera
Video Screen

Wall

Initial Field Value: | Component g

Name g -

Conditi J L
( AddPlug-in Object.. | [ Edit.. | [ Delete | [ AddDataSet.. | [ Delete | | | [ 7 | [ Define Mapping... | (1
| List of Mapped Data Sets.
Fig.. Wall data mapping
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|Usa |Objact Types/Object Names | |Attach |Data Sets/Fields I'I'ype |Fia|d Mapping |By Mapping | I ‘ |# |Shaat Name/Field Source
v SRS v @ Vectorworks Data Sets ' ~
ra Stage Plug SR wall Object [ NN ] Add Data Set 7
v Stage Ramp v @ IFC Data Sets
v Stage Steps Conditi..
v Stair (> Vil IfcWallStandardCase Primary ) [|mat l
& Straight Truss e
v Structural Member B v Classification |Data Sats
v Swing Bolt - 3D Conditi
& Swing Eye Bolt - 3D S Pset_ManufacturerT... V  Ifc PSets .‘AII
I Switch Conditi Material
v ::’“ -3 pset WallCommon Pset_ActuatorTypePneu...
v e ) ' o o IfcWall Primary ) Pset_AirSideSysteminfor...
v Table and Chairs T P ElectricHeaterT
) set_ElectricHeaterType...
v Taper Pin (DIN)-3D =] ' Classification p Manuf T !.l'Pl
7 Taper Pin (Inch)-30D Congit set_ManufacturerTypeln...
v Tee _.3.[) > 7 Pset_ManufacturerT.. Pset_ManufacturerTypeln...
v Television Conditi... [> Ifc PSets (Custom)
v Th_umb Screw (Inch) - 3D =3 o Pset_WallCommon WV lfc PSets (Standard
g ;mlat Stall & 7 IfcWallType Primary Material
russ sy
=3 IfeBuildingElementPart Secon...
& Truss Cross o g Pset_ManufacturerTypeln...
o Tubular Rivet (DIN) - 3D [= IicEntities
7 U-Bolt - 3D -} ol
v Utility Cabinet
7 Video Camera [ Manage Custom Property Sets... ]
v Video Screen Pri Entit -
7 Wall | Primary Entity o
[ Add Plug-in Object... ] | Edit.. | | Delete | [ Add Data Set... ] [ Delete ] \ 7 | Define Ma T | fe
| List of Mapped Data Sets.
L v
L
X % Object Info - Data =1
g
e ® Data Manager Shape [ Data l Render |
'wall
Data Sheet: | <Default Settings= ¢)
Settings: | <Active Settings> [ [ Open... ] [ Save... ] [ Manage... ] IFC version: _} IFC language: | Criginal Record Formats:
Bautell-ID
Objects: [ | Data Sets Attached by this Mapping: [ | v <Default ase>|_Custom pets... ]
o lfcwWalliStandardCase
|Usa |0hject Types/Object Names | |Attach |Data Sets(Fields I'I'ype |Fie|d Mapping |By Mapping | o Pset_walicommon
v ;;"‘"’ ;"' t v (@ Vectorworks Data Sets Pset_Elementshading
v age Flug > 7 Wall Object... I: e —
o Stage Ramp v @ IFC Data Sets
o Stage Steps - Conditi I: o Classification
7 Stalt =3 o IfeWallStandardCase Primary Classification2
v Straight Truss Conditi... Classification3
Structural Member P
? Swing Bolt - 3D =3 o Classification “Attach Recard
X Conditi... Attach IFC...
o Swing Eye Bolt - 3D v 7 Material s
v Switch Component 1 STRING -
o T-Bolt - 3D Component 2 STRING [ 1 [ErendzEn | ]
v Table ' Component 3 STRING Companent 2 [ ]
o Table and Ghairs Component 4 STRING Companent 3 [ ]
? I’p‘" gf“ ::)"‘:]'33[; Component & STRING Component 4 [ ]
aper Pin (Inch)-
p”_ Component 6 STRING Component 5 | |
v Tee - 3D Component 7 STRING
v Television Component 8 STRING Component € [ I
o Thumb Screw (Inch) - 3D Conditi Component 7 [ ]
v Toilet Stall =3 of Pset_ManufacturerT... Crocmenty| ]
o Truss ) A
7 Truss Cross (. (BN Define Mapping
o Tubular Rivet (DIN) - 3D . ) Name:
7 U-Bolt - 3D © Simple formula () Expert formula () Remove mapping ame: |
o Utility Cabinet
v
4
v



The assignment takes place via the name of the com-
ponent of the created floor/slab style.

The assignment takes place via the class name of the
component.

The assignment takes place via the class name of the
component for the IFC entities "IfcMember” and "If-
cBeam”.

You can save the settings made as a user-defined
data set.

000
Settings: (<Document's Setti... c] [ Open... J Manag:
Objects: | | Data Sets Attached
|Use |Object Types/Object Names | | |Attach |Dat
> Class-based Objects
> Symbol Definitions
> Plug-in Objects (Third Party)
> Plug-in Objects (Built-in),
'S
® 9 Save Mapping Scheme
Save the current set of Data Mappings and Data Sheets as:
FRILO Settingg| |
ntire Mapping Cheme () Selected Object Only
Save to User Folder
fUsersffranksaenger/Library/Application Support/Vectorworks/2022,
Save to Workgroup and Project Folders
# |Use |I'u der Location
(Ad
| For Help, press F1 or click the ? icon.
List

L

Fig.: Save FRILO Mapping scheme

-

‘ Settings: | <Active Settings> E [Open...] [ Save... ] [ Manage... ] IFC versio

Objects: | |

Data Sets Attached by this Mapping:

|use  [object Types/Object Names

|sttach |Data Sets/Fields

RECEQTECE

T . v @ Vectorworks Data |
v Rectangular Tubing - 3D =3 f A Slab
v RenderMall Plant v $ IFC Data Sets
v Retaining Ring [ASME)-3D
c? Retaining Ring (DIN)-3D =3 IfeSlab
v Retaining Washer (DIN)-3D
v Rivet (DIN) - 3D > Classificatic
v Rivet - Large {Inch)-3D
v Rivet - Small {Inch)-3D v Material
v Roadway (Curved) ' Compe
v Roadway (Custom Curb) Compe
v Roadway (NURES) Compe
v Roadway (Poly) Compe
v Roadway (Straight) Compe
v Roadway (Tee) Compe
v Roof Compe
v Roof Face Compe
v Rope and Stanchion
v Round Tubing - 3D =3 o Pset_Manuf
v Round Wall B
v Seating Layout =3 o Pset_SlabCo
v Seating Section =] f |f:s|aBTyp—o
v Sheet Metal Screw - 3D =3 o IfeFlowTerminal
v Shelving Unit
o Simple Stair SR Material
v Site Model
v Slab
.
( AddPlug-in Object... | [ Edit.. | [ Delete | [ AddDataSet.. | [ Delete | [
| Displays the current ion of the Data Tab in the Object Info Palette.

L
Fig.: Data mapping slab
oCe
‘ Settings: | <Document's Setti... [ [ Open... ] [ Save... ] ( Manage... ] IFC versio
Objects: | | Data Sets Attached by this Mapping:
:
[use  |obiect Types/Object Names | | |attach |Data Sets/Fields
& Class-based Objects v @) Vectorworks Data
=3 Symbol Definitions =4 " Column
= Plug-in Objects (Third Party) v @8 IFC Data Sets
v Plug-in Objects (Built-in
o {Legacy) Hoist = IfcColumn
o Acorn Nut (inch)-3D
o Angle - 3D =3 Classificatio
o Base Cabinet
o Bath-Shower v Material
o Elended Projector Compc
o Blended Screen Compe
o Break Opening CW Compc
o Building CW Compc
o Bulb Flat - 3D Compe
o Carriage Bolt - 3D Compc
o Ceiling Grid Compc
o Channel - 3D Compe
o Circular Stair
o Clevis Pin (DIN)-3D =] o Pset_Colum
o Clevis Pin {Inch)-3D =] o IfeColumnType
o Clevis Pin (Metric)-3D =] o IfeCovering
o Clothes Rod
o Column =3 & Material
o Comm Device
o Compartment Sink
o Cotter Pin {Inch) - 3D
Countar Tan .
( AddPlug-inObject.. | [ Edit.. | [ Delete | [ AddDataSet.. ) | Delete | [
| List of Mapped Data Sets.
L

Fig.: Data mapping Column
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Data Manager

~
7

IFClanguage: | Orignal &

Data Sheets for this Mapping:

X + Object Info - Data

Shape [ Data lkandar |
Slab

mn
3

Data Sheet: | <Default Settings>

Record Formats:

[Type [Field Mapping By Mapping | |#  |sheet NamejField Source |Label By Mapping
Sets Bauteil-ID
Object... 2 v <Default lfcSlab> Custom pSets...
|: [ NN ] Define Mapping o lcSiab
Cond
PCIII'I Pset_ReinforcementBarPitchOfSlab
fimary © Simple formula () Expert formula () Remove mapping o Past_SlabCommen
n Pset_ElementShading
Initial Field Value: [ Component B (Name B (| v e
Classificati
nent 1 STRING  =COMPON... o Classffication
nent 2 STRING Classification2
nent 3 STRING T —
nent 4 STRING Attach IFC...
nent 5 STRING Datach,
nent & STRING T —|
nent 7 STRING Component 1 | |
nent 8 STRING Component 2 | ]
Cond Component 3 | |
acturerT... Component & [ ]
Conditi...
onait Component 5 | |
mmaon
Primary Component & | |
Component 7 | ]
Component & | ]
l_] Name: |
L e e [ ok
0K
A
Data Manager ?
X 4 Object Info - Data =7
~ . S0 ~ P—
(23 @ rFciangusge: | Original <) Shape | Data | Render |
Column
| Data Sheets for this Mapping: Data Sheet: [ <Default Settings> g]
' Record Fi
. . 2COrt ormats:
ITypa |Fie|d Mapping [By Mapping | |# |Shaat Name/Field Source Label By Mapping
Sets abgeh. Decken Koten
Object... Bauteil-ID
v Hecotumn
Cond o lfeColumn
Primary
L 'S . B Pset_ColumnCommen
Conditi... [ NON ] Define Mapping L
n ¢ Pset_ReinforcementBarPitchOfColumn
Con - 1 "
© Simple formula () Expert formula () Remove mapping Pset_ElementShading
t1 STRING o Materia
nen
ags " Classification
nent 2 STRING Initial Field Value: [ Class Name g] [ S |- 7
nent 3 STRING attach Record
nent 4 STRING Attach IFC...
nent & STRING Detach...
nent & STRING I
nent 7 STRING Gompenent 1 }
nent 8 STRING Compaonent 2 | |
Condi Compaonent 3 | |
"Comman Compaonent 4 | |
;:maw Component & | ]
COMN...
Component 6 | ]
Component 7 | ]
Component & | |
: Name: |

Define Mapping

| Mapping Source.
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IFC export from VECTORWORKS 3. If required, enter the project data in the other cate-

If the model is properly filtered, it can be passed on to gories of the dialog window.

the structural engineer as an IFC file for further pro- 4. Check the assignment of the design layer of the

cessing. All visible objects are exported with the Ex- model to the IFC Storeys in the "Layer Mapping”

port IFC project command. Follow these steps: tab. So it should make e.g. the design layers and
walls of the ground floor assigned to the ground

1. Select File » Export » Export IFC Project. floor Storey.

2. Make the following settings in the "IFC export set- 5. If you click OK, the model is exported as an IFC file.

tings” dialog box:

= Select the model view "Simplified Geometry”.

= Activate the option Export Visible Objects Only.
This ensures that only the objects of the layers
and classes that are now visible are exported.

= Note: the decisive factor is not the current visi-
bility of an object, but the visibility of the design
layer or class in which the object is located.

s N ™y
[ NN ] Export IFC Project ?
Data | Layer Mapping
Export Options
Project Data Export Options
Author Data § -
Author Addresses File Format: [ de @
Organization Data IEC Version: [ 2%3 @
Organization Addresses
Site Data Model Export
Site Address
Building Data Model View: [ CV 2.0 - Architecture a]
Building Address i
Add-on Views:
Quantity Take Off
[C] 1st Level Space Boundaries
Export Options:

Export Visible Objects Only

[ Export Site Model

Export Custom Property Sets

Export Solids Operations as BREPs

[_] Export Text in Unicode Format

] Export Walls/Slabs by components

| check to export text in Unicode format. Tha Unicode farmat is more reliable for double byte charactars but not all programs support it. |
L v
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From the Architectural model to the
Analytical model

IFC import from VECTORWORKS

The basis for working with the FRILO BIM-Connec-
tor® (FBC) is a well-structured architectural model
that has been reduced to the shell. In the case of a
shell model, windows and doors were also hidden in
addition to the site. Ideally, the finishing elements and
the insulation are no longer available.

Start by opening a File » New (from IFC/SAF).
The physical model of the imported IFC file of the ar-
chitect opens (Fig. 7).

After you have opened the physical model, two im-
portant steps follow so that the export to the FRILO
programs works correctly.

Step 1: Clean up the Physical model

The physical model for component design is prepa-
red in the FRILO BIM-Connector® (FBC). To do this, it
has to be cleaned up.

1. Remove non-relevant components
After the IFC file has been imported, the Physical
model should first be cleared of all components
that are irrelevant for the calculation. The fastest
way to do this is to use the "Load transfer via ma-
terial" function in the group of functions for load
transfer. Here all components relevant for load

transfer can be set to "load-bearing” and all com-
ponents irrelevant for load transfer to "non-load-be-
aring” (Fig. 2).

. Specifications for calculation and material

The ,Specifications” function offers a convenient
way of specifying material qualities. The "Specifi-
cations” function can be used to specify material
qualities that are to be used if the components
have not been explicitly assigned a material qua-
lity. Furthermore, the corresponding design stan-
dards can be specified here (see Fig. 3).

. Assign the material

Another option for defining materials or quality of
material is offered by the ,Material” function in the
ribbon bar. The materials used are shown in diffe-
rent colors. Gray components consist, for example,
of concrete or pink components of masonry. The
red components are still missing any material assi-
gnment. With the help of the various selection and
display options (visibility, model structure, etc.), for
example, all walls can be selected in no time at all.
With the help of the ,Material” (properties) func-
tion, all selected walls can be assigned the appro-
priate material and the associated material quality
with one click (Fig. 4).
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Fig.1: The imported Physical model

Load-bearing behavior

About (® Mame () Category () Description Member thickness

Blockwork & = 15.0cm) (®) Donotchange () Mondoadbearng () Loadbearing
Concrete (® Donctchange () Mondoadbearng () Load-bearing
Concrete & = 15.0 cm) ® Donctchange () Mondoadbearing () Load-bearing
Concrete & = 17.5cm) (® Donotchange () Mordoadbearng () Load-bearing
Concrete & = 30.0 cm) (®) Donotchange () Mondoadbearng () Load-bearing
Concrete & = 60.0 cm) ® Donctchange () Mondoadbearng () Load-bearing
Steel (@ Donotchange () Mondoadbearng () Load-bearing

All do not Al non-bearing All bearing B auto Cancel

Fig. 2: Set non-relevant components to ,non-load-bearing”

Specifications for calculation and material

E Reinforced concrete

[2%es EN 1992:2015 +| Reinforced concrete (C 25/30 - B 5004)

EE Masonry

L2 S EN 1996:2007 Masonry (Mz-15.0-1.0-M5.0) Material assignment
Timber Matenal type
™o En 12352013 ~| Timber (Seftwood C24) |Masonry v |
Masonry (Mz-15.0-1.0-M5.0) Select
Il Construction steel
M0 EN 1593:2015 Construction steel (5235
oK Cancel
Fig. 3: Define material qualities Fig. 4: Assign the material
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Fig. 5: Components without material quality

As soon as all components have the correct materials
(Fig. 5 and 6) and the model has been cleared of the
non-load-bearing components, you can switch to the
Analytical model. Only the load-bearing components
are shown there.

Step 2: Adapt the Analytical model
In the second step, the Analytical model is adapted.
Various functions serve as the basis for this:

1. Join - intersect gravity lines

Finally, all that remains is to cut the components
together. The "Join automatically” function is sui-
table for this (Fig. 7). Depending on the size and
complexity of the building, it is also advisable to
use the “Join” function only for the floor in ques-
tion, as a great deal of data is processed with this
function.

2. Move components
Axis-related modeling is particularly important for
vertical load transfer. With the ,Move components”
function, the component axes can be pushed over
one another so that the loads can be passed on.

Fig. 7:  Unconnected (above) and connected com-
ponents (below)

Fig. 6: Components with assigned material grades

3. Disassemble walls

Using the “Disassemble walls” function, either all
walls at once or only the selected walls can be divi-
ded into strips or individual components according
to their openings (function “... into wall strips”, Fig.
8). This means that existing openings can be taken
into account in the Analytical model.

Fig. 8: Division into wall strips

. Calculated thickness

Using the "Thickness” function, surface elements
(walls, floors) can be assigned a new calculated
thickness.

. Conversion

With the ,Conversion” function, flat components
can be converted into rod-shaped components and
vice versa.

. Clean up the geometry

With the ,Reset geometry” function, small reces-
ses and openings as well as small beam sections,
columns, walls and slabs, which should not be ta-
ken into account in the static calculation, can be
removed.
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Step 3: Export to the FRILO programs o Messages

After clearing of the Physical model and preparing the Analytical model, = = Statist
a component can be selected in the next step and either transferred to I
FRILO dimensioning program A Editor

: Slab dimensioning with PLT

1. via the export button or Bl Column design with B5 +

2. via right-click » Export. El Building calculation with GEO

If no component is selected, all components from the Analytical model are automatically transferred to the
GEO Building model. The component design then takes place in the Analytical program.

Frequently asked questions

= Which FRILO design programs are linked to the BIM-Connector®?

In the 2021-1 release, the BIM-Connector® is connected to the PLT Panel Program and the Reinforced

|
|
|
|
I Concrete Column B5+. With the 2022-1 release, the FRILO Building model GEO will also be connected.
|

= Which file formats can the BIM-Connector® import?

The BIM-Connector® can import both IFC files (IFC 2x3 and IFC4) and SAF files.

= Which settings when exporting the IFC models from a CAD program favor the import into the BIM-Con-
nector® FBC?

The quality of the derived Analytical model depends heavily on the underlying IFC model.
The best results are obtained when the model:

- only includes the shell (e.g. IFC Design Transfer View, IFC Reference View)

- is well structured

- uses the relevant component types

- the components have assigned a material (at least material name)
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